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1. PDFMarkz SE App Overview
PDFMarkz SE For Windows is a Streamlined Edition of PDFMarkz, Markzware’s stand-alone PDF to IDML
converter for macOS.

PDFMarkz SE allows you to convert your PDF files to IDML and open the IDML in programs that support
handling IDML files.

Another great feature of PDFMarkz SE is that it is a stand alone program and thus you do not need any
other applications installed on your computer to convert PDF files to IDML. However, you will need
additional software loaded on your computer to take advantage of opening or automatically opening
IDMLs created using PDFMarkz SE.

PDFMarkz SE has a simple interface that allows you to either drag PDF or Illustrator files onto the main
window and convert them to IDML, or use Control-O to bring up an Open File dialog allowing you to
select the PDF file you wish to convert.

Programs that handle IDML include InDesign (CS4 and Later), QuarkXPress 2018 and later
and Affinity Publisher 1.8 and later. Thus PDFMarkz SE can act as a PDF to InDesign
Converter, a PDF to Quark converter or a PDF to Affinity Publisher converter.
*
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2. PDFMarkz SE Quick Start Guide

Here’s how to get up and running quickly using PDFMarkz
SE

1. Download the PDFMarkz SE Installer
2. Double-click on the Installer and follow through the instructions
3. Activate PDFMarkz SE using the License ID and Activation code you received when you purchased

the product
4. Once activated you will see the main screen for PDFMarkz SE
5. On this screen you can drag a PDF or Illustrator file onto the Drag-n-Drop zone at the bottom of the

Window
6. Your file will be converted to IDML and the IDML file will be placed in the folder specified in the Create

IDML In section.
7. It’s that simple. You now have an IDML file you can open in apps that support IDML such as any

version of InDesign (CS4 or later), QuarkXPress 2018 or later, or Affinity Publisher 1.8 or later. (The
app you select to open the IDML must be loaded on your system).

8. If you want to automate opening the IDML in the application of your choice, you can set this up under
the After Conversion section under the Open IDML in area.
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3. PDFMarkz SE System Requirements
• Windows 10 and Windows 11 (64 bit)
• Minimum of 4 GB of RAM (16 GB recommended to handle opening the IDML in other applications)
• 1GB of available hard-disk space
• SSD (Solid State Drive) recommended for better performance
• Minimum of 1024 × 768 display
• Internet Connection
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4. PDFMarkz SE Installation
1. Download .msi file
2. Double-click on .msi file

3. Follow thru the install screens
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4. The Installer may take a minute or two to set things up.
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5. You may see a UAC (User Access Control) window asking if it is OK to make changes to your device.
Click on Yes

6. After the User Access Screen closes, the Installer begins installing PDFMarkz SE
Once Installation has completed, click on the Close button to finish up the installation
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7. When the install completes you will see the PDFMarkz SE activation screen

8. You must activate PDFMarkz SE in order to use the product
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4.1. Installing .NET 6
The newer versions of PDFMarkz SE require Microsoft .NET 6 in order to run. If you start up PDFMarkz
SE and see the following alert message, please use the following procedure to install .NET 6

1. Click Yes on the alert window stating you must install missing frameworks for .NET

2. Your default web browser will start up and display the .NET 6 Download Page. Make sure you
download the Desktop x86 version. You may already have the Desktop x64 version loaded, however
PDFMarkz SE is a 32-bit application and requires .NET6 ×86. Don’t worry you can have both the X86
and x64 versions of .NET installed on your computer.
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3. To start the install, double-click on the windowsdesktop-runtime…x86.exe file

4. When the .NET Installer window comes up, click on Install .
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5. A User Access Control window (a UAC Window) will come up asking if it is OK to make changes to
this computer- Click on Yes .

Make sure the .NET 6 version is the (x86) version. This is seen in the upper right corner of
the .NET 6 install screen*
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6. You should see a progress bar showing how the .NET 6 installation is progressing.

7. When the .NET 6 installation has completed, you will see a message that Installation was
successful. Click on the Close button to dismiss this window.
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8. If this is the first time you have run PDFMarkz SE, you will need to activate PDFMarkz SE in order
to use the product.

9. If you updated PDFMarkz SE from a previous version that did not require .NET 6 to run, you
should simply be able to run PDFMarkz SE by starting it up.
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5. PDFMarkz SE Activation
1. When you first launch PDFMarkz SE you will be prompted to activate the product. PDFMarkz SE will

not run unless activated

2. Enter in the Email address used when you purchased PDFMarkz SE.

3. Enter in the License ID you received when you purchased PDFMarkz SE.It is easiest to copy and
paste the License ID instead of manually trying to type it in.

Markzware PDFMarkz User Guide - SE for Windows_en

©2023 Markzware Page 15 of 30



4. If you enter an invalid License ID or Email Address you will receive an error message.

5. If the Email Address and License ID are entered correctly, PDFMarkz SE will open up and the main
Window will appear. Once you have confirmed you are successfully activated, please close the status
window.
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6. If you would like to check the activation status of PDFMarkz SE at a later time, go to the Help Menu
and select About.
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6. PDFMarkz SE Menus Overview
PDFMarkz SE File Menu
PDFMarkz SE Window Menu
PDFMarkz SE Help Menu
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6.1. PDFMarkz SE File Menu
The File menu contains items that allow you to open files and Quit PDFMarkz SE

Open

Selecting Open brings up a standard Windows Open File window allowing you to navigate to and select
the PDF or Illustrator file you would like to convert. You can also use the shortcut key combo of Control-O.

Open Recent

The Open Recent menu item contains a list of the most recently converted files. This can be handy if you
have made changes to a file and wish to reconvert it.

Exit

Selecting Exit will quit the PDFMarkz SE program. You can also use the shortcut key combo of Control-X.
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6.2. PDFMarkz SE Window Menu
The Window Menu contains a single item named

Show Status Window

Show Status Window brings up a Status window where you can see information regarding files you have
already converted. This window is also useful as it shows any files that failed to convert. Thus, if you are
missing an IDML file, please open this window and see if the file error’d out during conversion.

The shortcut key-combo to bring up the Status Window is Control-S*
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6.3. PDFMarkz SE Help Menu
The Help Menu contains the following items -

User Guide

This is a link to the online User Guide for PDFMarkz SE

Online Tutorials

This is a link to online tutorials (usually movies, so you can see PDFMarkz SE in action)

Report and Issue

Clicking this will bring up Markzware’s online Trouble Ticket form where you can report issues.

About

Clicking this brings up the About PDFMarkz SE window. In this window you can -

• See the Activation Status of PDFMarkz SE

• Deactivate PDFMarkz SE

If you are having issues with a file not converting, please use the Upload file section of the
online form to send us the file so we can test it at Markzware and try and find a solution.

!
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7. PDFMarkz SE Deactivate and Uninstall
Following are the steps to Deactivate PDFMarkz SE. These are required if you are going to move
PDFMarkz SE from one computer to another or retire a computer and at a later date install PDFMarkz SE
onto another computer or a new computer.

1. First deactivate PDFMarkz SE on your current computer

2. Now you can install PDFMarkz SE on your new computer

Deactivation Process
1. Go to thePDFMarkz SE Help Menu and select About

2. This will bring up the About PDFMarkz SE window. Click on the Deactivate button
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3. This will bring up a confirmation window asking if you would really like to Deactivate PDFMarkz SE. If
you do, then click on the *Deactivate button. If you wish to cancel and not deactivate PDFMarkz
SE, click on the red close button in the upper right corner.

4. Once you Deactivate PDFMarkz SE, you will see the initial Activation Screen. Close this window by
clicking on the red close button in the upper right.
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Now you are ready to Uninstall PDFMarkz SE
1. Open up your Control Panel for Microsoft Windows. Under the Programs area, click on Uninstall a

program

2. Navigate down the list until you find an entry for PDFMarkz SE
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3. You can right-click on the PDFMarkz SE entry and select Uninstall from the popup menu or you can
single-click on the PDFMarkz SE entry and then click on the word Uninstall.

4. Either of these methods will bring up a window asking if you are sure you want to Uninstall PDFMarkz
SE. Click Yes to continue uninstalling PDFMarkz SE.
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5. You will see a window telling you Windows is preparing to remove PDFMarkz SE

6. The Uninstaller will do “some stuff”

7. When the Uninstaller completes it will automatically close and you will see the Control Panel->
Uninstall window. Close this window.

8. You can now install PDFMarkz SE on your new computer system.
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8. PDFMarkz SE Conversion Notes &
Limitations
Batch Processing

You can batch process PDFs and have them open in InDesign, only if none of the jobs have missing
fonts or images. Otherwise, only the first job in the batch will open in InDesign.

if you enable the Open In settings in PDFMarkz SE (for example you select Open in and then System
Default), only the first PDF file will open in InDesign if any of the files in the batch have missing fonts or
images.

If none of the jobs in the batch have missing fonts or images, then all files in the batch should open in
InDesign. Thus, the issue is how InDesign is handling popup dialogs during batch conversion. FYI – you
will run into this same issue if you batch open InDesign files within InDesign itself.

If you Disable the Open In setting in PDFMarkz SE, then all files regardless of whether they have
missing fonts or images will convert to IDML. Please be aware that if any of the jobs have missing
images and you have not set PDFMarkz SE to create previews for either All or Missing images, the
IDML job created will have missing images as no lo-res previews would be generated.

Status Window doesn’t update when closed

If you convert files and the Status Window is not open, it will not update the converted file count. If you
wish to see an accurate list of the files you have converted, first open the Status Window by doing
Control-S and then begin converting your files.

Open IDML in QuarkXPress cause Quark to open in Demo Mode

If you set PDFMarkz SE to automatically open IDML files in QuarkXPress, this may bring Quark up in Trail
mode. To address this issue, please start up QuarkXPress first, then start up PDFMarkz SE and convert
your PDF files. The IDML file sent to QuarkXPress while it is open will not cause Quark to go into trial/
demo mode.
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9. PDFMarkz SE FAQs & Troubleshooting
Q. – I keep getting an error when attempting to Activate PDFMarkz SE. What’s the problem and how do I fix
it?
A. – if you receive an error when attempting to activate PDFMarkz SE, then either the License ID and/or the
Activation Code have been input incorrectly. This is usually the result incorrectly typing in the long sequence
of characters that make up each code.
The best way to alleviate this issue is to copy and paste the License ID and Activation Code into the proper
areas on the Activation Window

Q. – I want to move PDFMarkz SE to another computer. How do I do this?
A. – First please deactivate PDFMarkz SE and then Un-install PDFMarkz SE. You can find step by step
instructions in the Deactivate and Uninstall section of this manual.
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10. PDFMarkz SE Release Notes
PDFMarkz SE Release Notes
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